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ABSTRACT

A series of Internet workshops funded through the Research
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and educational database searches, and the use of search engines. The second
workshop covered the use of Usenet and newsgroups for information sharing and
teaching. The third session presented successful examples of the use of the
Web in building rich pedagogical and curricular environments. The fourth and
fifth sessions prepared participants to design and produce their own Web
pages. Following the completion of the training, participants will be able
to: (1) navigate and do searches on the Web using a Web browser; (2) identify
legal and ethical resources for determining the legality of options from
on-line graphics to copyright law restrictions; (3) identify curricular areas
that can be supported well with Web resources, and those that cannot; (4)
identify free and commercial sites on the Internet that are available to
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Workshop Overview

Introduction
A series of Internet workshops funded through the Research Excellence Fund of
the State of Michigan and administered by the Projects for Urban and Regional Affairs at

the University of Michigan-Flint was provided to all of the educators in Beecher
Community School District, Flint, Michigan. Training consisted five workshops of 2
hours duration each during the beginning of the winter semester of the 1998-99 academic
year. The first workshop introduced the definition and history of the WWW and provided
instruction on online library and educational database searches, and the use of search
engines. The second workshop covered the use of Usenet and newsgroups for information
sharing and teaching. The third session presented successful examples of the use of the
Web in building rich pedagogical and curricular environments. The fourth and fifth sessions

prepared participants to design and produce their own Web pages. This manual was
designed for the Internet training workshops.

Objectives
Following the completion of the training, participants will be able to:
1. Navigate and do searches on the Web using a Web browser
2. Identify legal and ethical resources for determining the legality of options
from on-line graphics to copyright law restrictions
3. Identify curricular areas that can be supported well with Web resources,
and those that cannot
that are
4. Identify sites on the Internet - both free and commercial
available to support specific classes
5. Use the jargon of the Internet
6. Understand how Web page are designed and the coding that is needed to
create these pages
7. Participate in support groups and develop skills that can provide for local
district/building needs
8. Employ effective instructional strategies when teaching with the Web.
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Activity 1: What is WWW?
Definition
The World Wide Web (WWW), also called the Internet, is a network, or web, of files on
computers all over the world, connected with hypertext links, always underlined and
usually in blue. You select a link by clicking with the mouse.

History

The Internet had its beginnings in the late 1960s and early '70s, when the U.S.
government and military were interested in developing computer networks that could
survive nuclear attack. They wanted a system in which individual sites could be linked
and not are dependent on one another. If Site A and Site Z were linked, they could
continue to communicate, even if Site B crashed.

In 1969 ARPANET arrived, a network that had no central control point. It linked only
four military research centers, but it grew dramatically in subsequent years, inspiring
similar network innovations. By 1980, people were calling this new vessel the "Internet."

The Internet's teenage years began in 1989. It had grown immensely. All kinds of
information and data now coursed through its veins, but it had a problem: PC users had
no consistent way to retrieve material. At CERN, the famed particle physics research

facility located outside Geneva, Switzerland, researchers began looking for a new
method.

In 1990, ARPANET was phased out, and the Internet largely lost its military orientation.

The National Science Foundation's NSFNET became the backbone provider to the
Internet, which developed an entirely new personality: it has become a friend of ordinary
people! What was once the devoted tool of institutions has become the popular tool for
students, office workers and families around the world.

As clamor for commercial access to the Internet grew, many small entrepreneurial
companies sprang up to provide services. By 1990 several commercial providers had
entered the market. Twelve months later, these pioneers started the Commercial Internet

Exchange (CIX) to give businesses direct access to the Net. Three years later,
commercial vendors totally eclipsed NSFNET.

The market offered no commercial products, so CERN developed a protocol on its own,
the Hypertext Transmission Protocol (HTTP) that now graces every Internet home page.
CERN also developed an HTTP browser for computer terminals. This was the origin of
the World Wide Web.
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CERN released HTTP to the public in 1992. In 1993, students at the University of
Illinois, working with the National Center for Supercomputer Applications (NCSA),
developed Mosaic, a graphical HTTP browser and the first real Web browser. It was an
instant hit on college campuses and quickly spread to the business and corporate
communities. A few programmers left Mosaic to form Netscape Communications Corp.,
which today markets the world's most popular Internet browser.
The Web, with its ability to provide user-friendly graphics and text, gave the Net its adult
look and feel. Today, the Net has more than 40 million users worldwide. Morgan Stanley,
the financial services company in New York, estimates that by 2000 the number will
quadruple to 160 million.

But the Internet in its present form was never meant to support that many users. And it
certainly was never meant to provide them with the kind of fault tolerance and assured
delivery that business users expect.

In short, it was never designed to be such a free-wheeling adult. It was designed to
support only a few military sites under the unusual conditions of full-scale nuclear war,
with very low expectations of any one message reaching its destination.

However, the vast numbers of Web users are beginning to overwhelm the Net's
connections, and it's too late to turn back. Already, the Internet has suffered brown-outs,
where service was delayed or horribly slow, and in the near future, these may expand to
full-scale black-outs.

To add to the strain, the Internet has become a business tool. Every day, thousands of
persons in business, government, and academia exchange e-mail, browse catalogs, and
buy products and services. There is even a new term, Intranet, to describe internal
Internets that companies and colleges build on their own local-area networks.

SOURCE: This is a paraphrase and adaptation of: "White Paper: Lucent Technologies
and the Internet: The Internet in History." Lucent Technologies, 1997.
http ://www lucent. com/internet/wp 1 html (August 19, 1997).
.

.
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Activity 2: Navigating the Web: Treasure Hunt 1
The following Treasure Hunt is designed to take you on a trip on the World Wide
Web using a Web browser. You will be taken to sites that are informative. Some questions
will be asked which relate to these sites. These questions will relate to items on the site, and
are intended to reinforce your navigating skills.
Many terms are online at the PC Webopaedia (http://www.pcwebopedia.com/) site
for your reference. At PC Webopaedia, you can search for meaning and definition of terms.

You can tell the difference between a glossary term and a site URL. You will also

find Hints and Navigating Tips that will be available after you have tried to answer a
question on your own.

Another critical issue how can you get back to the page where you were from a
page to which you have traveled? Try the Back Button successive clicks of the Back
Button.

Please, relax and enjoy your trip! You really cannot break the machine, and if you
get stuck, ask for assistance! If you have suggestions, please put them on the comment
sheets.

Question 1

The History Channel
Uses this URL: http://www.historychannel.com

Hint: Type the URL (Universal Resource Locator), http://www.historychannel.com. into
the location bar.
To go to another page from the History Channel main page, move the mouse around until
the pointer turns into a hand with a pointing finger. If you think the link that the hand is
pointing to may contain the answer, click on it. If it doesn't have the information once you
get there, click the Back Button.

University of Michiganlint - Netscape

Ci.What*i4cd

Location Bar
I

A

Navigation Tips: This is the location bar. You will need to click in with your mouse to be
able to type in the URL.

BEST COPY MAI BLE

8

6

Session I: Telesearching

Part A: What happened on this day in history? How confident are you that this information
is accurate?

Part B: What day is your birthday?

Name two things that happened in

history on the day you were born.

Question 2
NASA
Uses this URL: http://www.nasa.gov

Hint: In the location bar, enter: http://www.nasa.gov

The title is found at the very top of the window. It is the name that appears when you
bookmark a page. Bookmark the page to see if you have chosen the correct title.

Navigation Tips: To bookmark a page, click on Bookmarks icon in the tool bar and then
choose Add Bookmark.
Part A: What is the title of the Homepage for NASA?

Part B: What do you find on this page that would be helpful for Earth Science teachers?
Please list three items.

Click and open the menu under Bookmark. What are your options when you click this
button?
OR
OR

7
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Select Add Bookmark, close the menu, and open the menu again to see what has happened.
Check the bottom of the Bookmark List.

Question 3
Scholastic
Uses this URL: http://www.scholastic.com

Hint: Type http://www.scholastic.com into the location bar to answer the questions. Click
to enter the Scholastic site. As you click to enter, note that there are several ways to enter the
page. When you get to the next link one of your options will lead to a way to search this site.
Please also look for the cursor arrow change to "hand".

Part A: Does Scholastic have more than one option of where to go to from their main page?
How can you be sure of your answer?

Part B: Does Scholastic have a model of How to Write an Advice Letter for teachers of
expository writing? (Hints: Use Search at the left column on the screen.)

Status/
Progress
Bar

P

Navigating Tips: This is the Status/Progress Bar. Hold the pointer of the mouse over
several locations on the Scholastic page that is located at http://www.scholastic.com. At the
bottom of your screen, you should be able to see the URL's of these links in this bar. Write
down the URL that you see at one of these locations.

Now move the mouse to various other links on this same page without clicking. Watch how
the URL's in the Status/Progress Bar change from one location to the next. What do you
notice
about
all
the
links
on
this
particular
page?

BEST COPY AVAILABLE
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Click on any one of the options, and see if you can find a way to search this site. If you can,
click on that option, and when you get a Dialogue Box or Search Field, click in with your
mouse, and type in the name of the document that you have been asked to locate.

Question 4
The Guitar Net
Uses this URL: http://www.guitar.net

Part A: Type http://www.guitar.net into the location bar. Do not press Enter or Return yet.
What does the Stop button look like?

What does the "N" button in the upper right corner look like?

Part B: Read this entire question and then press Enter or Return. After pressing Enter or
Return, what does the Stop Button look like?

What does the N Button look like now?

Press the Stop Button. What does the browser display?

Part C: What happens when you click the Reload Button?

While you are on this page, click on Audio clip of this chord. What happened?

Part D: What kind of computer was used to create this site?

11
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Navigating Tips: Circled here are the Stop Button and the "N" Button - which happens to
be the logo for Netscape.
51Welcome to U of M-Flint - Netscape
Fie Edit

view

.F °mat_
71

4'bookmarks

Communicatm H ek)

H
md
inueow.

(13.14/hetiRelated---.

Locaticsdhapliwww.11int.unicitedu

Instant Menage i WebMail

LI Contact Q People.

Yellow Pages E) Download

Navigating Tips: After you have clicked on Audio clip of this chord, you will need to wait
while the file is downloaded to your machine. When you see the window above, click on
the arrow, and listen. Do you agree with the author of the web page? Is this the saddest
chord?

Question 5
Bellingham Schools
Uses this URL: http://www.bham.wednet.edu
Hint: Type http: / /www.bham.wednet.edu into the location bar and press Enter or Return.

Part A: What rules are available here about web use? How are these important for
educators?

Part B: Take a minute to visit a Virtual Museum on the Bellingham site. Write the name
below of the one that you visited. How can this type of activity be applied to your lesson?

BEST COPY AVAILABLE
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Question 6
Teacher's Guide to the Professional Cartoonist
Uses this URL: http://www.cagle.com/teacher

Part A: How can you use editorial cartoons in the classroom and where can you find them
online?

Part B: Quote from the site:

"The most compelling use of editorial cartoons is to interest students in
discussions of current events. Since the cartoons are constantly updating,
students will see the themes change to reflect the issue of the day -- for

example, recently the cartoonists all drew cartoons about the Mars
Pathfinder mission, cloning sheep, and the problems on the space station
MIR science teachers should check our site when science is in the news."
For which subject areas could you find lesson plans on the site?

Question 7

The Flint Journal On-line
Uses this URL: http: / /fl.mlive.com

Hint: On the Flint Journal Site,
1. Explore the Link that says "Today's Top News."
2. Look at the left frame and try the "Week at a Glance" link under News
3. What happens when you go to the bottom of the left frame and fill in any word in
the "Search our Site" box. Don't forget to select the Flint edition of the paper in the pull
down menu above the search dialogue box.
This should help you to answer the question in Part A.

Part A: Name three ways that you can see what local reporters have written about
community matters.

13

11

Session I: Telesearching

Part B: Name a major Flint event that has a web site devoted to same-day coverage.

Part C: What is today's weather in Flint?

Navigation Tips: Click on the weather box in the blue classified at the right side of the
screen.

Part D: Can you find an out-of-state city's weather? Can you find an out-of-country city's
weather? If yes, please write down the name of the city and its weather.

Question 8
Discovery Channel
Use the URL: http: / /www.school.discovery.com

Part A: What types of classroom activities does the Discovery Channel have for teachers?

Part B: Look at the menu on the left of the Discovery Channel main page. Click on the link
that will allow you to get a free copy of the Educator's Guide. See if you can register on-line
for this book.

Question 9
Teachers helping Teachers
Use this URL: http://www.pacificnet.net/mandel/
Part A: Does Teachers Helping Teachers offer any lesson plans?

Part B: What does the counter information tell you about this site?

14
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Activity 3: Treasure Hunt 2: Searching Via Search Engines
Definition of Search Engine
A program that searches documents for specified keywords and returns a list of
the documents where the keywords were found. Although search engine is really a
general class of programs, the term is often used to specifically describe systems like Alta
Vista and Excite that enable users to search for documents on the World Wide Web and
USENET newsgroups.

Typically, a search engine works by sending out a spider to fetch as many
documents as possible. Another program, called an indexer, then reads these documents
and creates an index based on the words contained in each document. Each search engine

uses a proprietary algorithm to create its indices such that, ideally, only meaningful
results

are

returned

for

each

query.

(Adopted

from

Webopedia,

http://webopedia.internet.com/TERM/s/search engine.html)

Instructional for Searching with Search Engines
The following Treasure Hunt is designed to help you explore some of the search
engines that are available for you to use over the Internet.
For each question, you will be asked to complete some information, and you will
be provided with some information that may make your search easier. Try to fill in the
information completely, so you will have a valuable off-line reference.

The most important thing for you to be able to do is to get an idea of the kind of
information and the manner in which it is accessed and displayed by each search engine.
Each may yield different results, and it is important for you to know why. You will learn
how to refine your search in the next lesson.

Question 1:
How many search engines are available? (circle one)
1.

2.
3.
4.

One
A few
Ten to 20
Hundreds
13
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Navigational Tips:
Click on the Search icon in the toolbar. Then the following window with search engine
tools will appear.
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Hint: There are a few search engines that are used most frequently. These few of the
most-used search engines provide you the ability to search on general information. At the
same time, there are literally hundreds of search engines for specialized areas such as

health, finance, travel, education and others. By learning about the general and
specialized search engines, you can become a very effective Internet researcher!

Question 2
What are some popular general Internet search engines (include the site name and URL in
your answer)? The first one is completed for you.

Engine
Engine 1

Name

URL
http://www.yahoo.com/

Yahoo

Engine 2
Engine 3

Engine 4
Engine 5

BESTCOPYAVAILABLE
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Question 3

Part A: What do these URL suffixes mean? The first one is completed for you; notice
that the suffix .com designates a commercial site.
Suffix

Type of Site

.com
.org
.gov
.net
.edu
others

Commercial

Hint: The term URL suffix refers to the last three letters of an Internet address. For
example, the Excite search engine address www.excite.com has the suffix .com.

You must always view information you acquire from the Internet with a discerning
attitude. When you get information from the Internet, it is similar to getting information
from a book or newspaper; it is always a good idea to ask yourself the question, "Who
put this information here and why do they want me to look at it?"

Part B: Judging from the suffixes of the search engine addresses you wrote down in
question 2, the search engines you looked at are what type of sites?

Please complete the following searching activities via search engine tools.

Question 1:

Weather Watch on the Web
Go to Search Engine home page, click on Lycos to go to Lycos Web page. Then, click
on Weather in the categories

Part A: Click on United States, City Forecast Summary. What do you get?

15
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Part B: Click on International, City Forecast Summary. What do you get?

Part C: Now, enter "Flint" in the city box and "MI" in the State box. What is the
weather in Flint?

Navigational Tips: You have to scroll down in order to the see the city and state entering
boxes.

Question 2

Making a Map or Driving Direction on the Web
Go to Alta Vista home page (http://www.altavista.com/). Then, click on Maps at the right
hand side of Specialty Searches.

Part A: Enter your home address. What do you get?

Part B: Click on the Find Driving Direction, Enter "Flint, MI" in Start session, and
"Miami, FL" in the End session. What do you get?

Question 3

Looking for a Michigan School Homepage
Go to Yahoo home page ((http://www.yahoo.com/).

Part A: Enter "Michigan Schools" in the entering box, click on Search. How many hits
do you get?

Part B: Can you find a K-12 school home page? If you do, please write down the name
of the school.

18
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Activity 4: Legal and Ethical Issues

Instructions:
Put an "X" mark on the continuum where the action best fits. Explain your
responses.

Legal

Grey
Area

Illegal

Action
1.

Copy a graphic from a commercial site for your
own web page.

2. Give your password to another user

3. Use someone else's account

4. Download software
5. Use clip-art from your library to your Web page
6. Borrow software from a school network
7.

Crack a password

8.

Modify / install software on a school computer

9.

Scan text from a book

10. Put your picture and full name on a web page
11. Download serial numbers or passwords
12. "Borrow" hardware components

13. "Make a copy of purchased software for another
user
14. Copy a program, but say you wrote it.
Note: You may check Copyright Management Center
(http://www.iupui.eduJit/copyinfo/) or NEA Addition Resources
(http://www.nea.org/neatoday/9711/epyright.html) for some copyright information
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Activity I: Email on the Web

L

You can send and receive email via the Web. To conduct the regular email functions,

you have to identify your email account and server under the menu bar, Edit,
Preferences. Then, you will see the following window. Please enter your name, Email
address, and affiliation into the appropriate boxes.
x
Category,

B

E.

Appearance
Fonts

r1

Colors

Set your name, email address, and signature Ida

Identity

O Navigator
Languages

The informatici below is needed before you can send mai U you do
not know the information requestetL please contact you system
administrate or Internet Service PrOvider.

Applications
Smart Browsing
Mail & Newsgroups
Idifiliirs
Mail Servers
Newsgroup Serve
Addressing
- Messages
- Window Settings
Copies and Folde
Formatting

Return Receipts
Disk Space

a Roaming Access

-

You Dame:

.

.1Liing Chen
.1.

Emai address:
.

Ilingchen@flintumich.edu
fieply-to ackkesstonti needed i ciftereht from &mai address]

Qrgarization:
The University of MichiganFlint
.

Zomba', Fie:

l- Composer

-rl

nff1;no

Eat Card.. I

r 'Attach my personal card to messages (as a vCard)

OK

Cancel

I

kieb

I

After this, please click on Mail Servers under the Mail & Newsgroups in the left
category box. The following window will show:

BEST COPY AVAILABLE
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Qategory:

B Appearance
Fonts
Colors

.

lied Sewers

Speedy servers lot mad

Incoming Mad Servers
Add...

B Navigator
Languages
Applications
Smart Browsing
B Marl & Newsgroups
Identity
Newsgroup Serve
Addressing
Messages
Window Settings
Copies and Folde
Formatting
Return Receipts
Disk Space
Roaming Access
El Composer
-roe

ror

Eck..
Qelete

To set server properties larch as checking for new
messages automatically). select a server and then
click Edit.

________

.

Outgoing Mail Server

km tlflil.

Qutgoing mad ISM T PI server

II

Outgoing mail server user name: Ilin.yrien

Use Sects° Socket Layer(SSLI or TLS far outgoing messages:
Neyer

r It eosstble

r Alleys

Local mai directory:

choose...

IC: \Program Files \Netscacre \Users \delault \mail

OK

Cancel

I

Help

I

Click on the Edit button to add, admin.beecher.K12.mi.us, into the server name box.
Enter your username into the User Name box. Then click OK.

You will go back to the above window. Please enter, admin.beecher.K12.mi.us, into the
SMTP server box, and your username in the Outgoing Mail server username box. Click
OK.

Now, you are ready to send and receive email on the Web!

BEST COPY AVAILABLE
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Click Messenger, under Communicator, You will see the following window.

wn©

;5, Netter:ism Mad - !Faculty development giant/
Fie

Edit Yew Homo. fio Qption. Yrclow delp

on al

I Tex1 111 I

FIE211® 111 51

5.j

p.

11.Thitiod

Mai Fold
Inbox

2

aengefj@Pavia.

FE1

- -Cl Drafts
Samples
-.13 Templates
Unsent Messages

2

,C4)

Date T

Sate'ct
sullenger_i@PaY60-

1.

- ea Trash

F7e I

Resl

2.!

-C3 [Sent

a

k..

Ili

pa 117,a1urnich.edu
greer_g@crobilint....
dalamb®qucis.que...
juanders®mtu.edu

LW, fishman@umichedu

Annual Fund Award
Annual Fund Award
Faculty developrnerd gtant
Research Initiative programs
password

course requiements
missed to see you

7/14/98 14:47
7/14/9814:49

r

7/1 4/90 14:50

7/14/9814:52
8/12/9812:08
10/7/9815:10
Thu 1231

Subject: Faculty development grant
Date: Tue, 14 Jul 1998 14:50:29 -0400
From: Li-Ling Chen <lingchen,@flittumich.edu>

Organization: Umf
To: pamills@umich.edu

Dear Pam:

I am pretty interested in getting information about Faculty
Development Grant.

Thank you very much for your assistance.

Regards,
[12.11
Nelattscape

otirrrer;ity

iletscapelfari,-,, [Rc =8 PH

Click on New Message to compose and send an email.

Click on Get Message to read your incoming emails.
Click on Sent to check the email you have sent out.
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Activity II: Usenet & Newsgroups
Definition:
A worldwide bulletin board system that can be accessed through the Internet or through

many online services. The USENET contains more than 14,000 forums, called
newsgroups, which cover every imaginable interest group. It is used daily by millions of
people around the world.

To subscribe a specific discussion group on the Web, please click under Window,
Netscape News.
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Subject: BOSS GUITARS CURRENT INVENTORY
Date: 19 Jun 1998 07:49:57 GMT
From: bossguitar@aol.corn (BossGuitar)
Organization: AOLhttp: / /www.aol.com
Newsgroups: urnich.music
If interested in any of the following items, please email me or call at
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Activity 3: Listsery

Definition:
An automatic mailing list server developed by Eric Thomas for BITNET in 1986.
When e-mail is addressed to a LISTSERV mailing list, it is automatically broadcast to
everyone on the list. The result is similar to a newsgroup or forum, except that the
messages are transmitted as e-mail and are therefore available only to individuals on the
list.

LISTSERV is currently a commercial product marketed by L-Soft International.
Although LISTSERV refers to a specific mailing list server, the term is sometimes used
incorrectly to refer to any mailing list server. Another popular mailing list server is
Majordomo, which is freeware.

Demonstration Site:

EdWeb
http://edweb.gsn.org/

Ed Web offers a collection of the best online educational resources available for K-12
students. These resources include newsgroups (public messages posted for everyone to
see), listsery discussion groups (these are like private newsletters; you subscribe to a
group focusing on specific topic and then receive the latest news and views on that topic
by email), and electronic journals.
Navigation Tips: To get to these groups, click Home Room at the bottom of the page,
scroll down, and click Educational Resource Guide.
When you reach the Ed Web K-12 Resource Guide, click USENET newsgroup for lists of
more than three dozen newsgroups for teachers and kids. The newsgroups focus on every
subject in the K-12 curriculum, including social studies, art, music, business education,
health and physical education, math, and many others. You can read what other teachers
think and, if you wish, write messages of your own.

You can click Listsery Discussion Groups and E-Journals to find a long list of education-

centered private newsletters (mailing lists) to which you can subscribe.

There is a

mailing list for about every topic of interest to K-12 educators.
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Activity 4: Web Conferencing
Definition:
An online discussion group. Online services and bulletin board services (BBS's) provide
a variety of forums, in which participants with common interests can exchange open

messages. Forums are sometimes called newsgroups (in the Internet world) or
conferences.

Demonstration Site:
http://www.forumhost.com/
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Activity 5: Live Chat on the Web

Definition:
Online chat means real-time communication between multiple users via computers. Once
a chat has been initiated, either user can enter text by typing on the keyboard and the
entered text will appear on the other user's monitor. Most networks and online services
offer a chat feature.

Demonstration Site
World Village Chat
http://www.worldvillage.com/wv/chat/hunlichat2.htm

The Web site provides four options of live chat: Java Chat, IRC Chat, Chat on
WebTV, and ICQ. There is a free trial version of ICQ chat for a limited period of time.
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Activity 1: Teleteaching Strategies

What can students do on the Web?

Take virtual tours of museums, cities, and foreign countries
Give students access to the latest information
Allow students to participate global projects
Bring experts from numerous fields right into the classroom (ask an expert)
Interact with people from around the worlds, via email, newsgroup, listserv,
chat, live video, audio, and so forth.
Post information for the World to see

Conduct a research on specific topic and make a report or write a paper.

What can teachers do on the Web?

Identify and provide appropriate educational resources for their students
Post their lesson plans on the Web to share with other professionals.
Initiate the opportunities of allowing students to participate external or global
projects.
Preventing students' access to adult materials on the Web.
Download images or files from the Web for instructional purposes

What learning activities could happen on the Web?
Group Instruction

Apply the Web as a demonstration tool for
illustrating information for whole class.

Cooperative Learning:

Assign students in small groups and conduct
research study on a certain topic.

Individualized Learning: Allow each student to look for certain information
in certain subject area and then have the student
make a report.
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Activity 2: Tips you should let your students know when you bring them on-line
Be a little cautious. You're not going to know as much as you'd like about those you
meet on-line.
Be aware that people may not always be who they appear to be. Someone who
claims to be a 12-year-old girl could actually be a 40-year-old adult.
Keep personal information private. Don't give your address and phone number to
strangers. Children should ALWAYS have their parents' permission before
communicating personal information.
Don't give out your parents' names either.
Never agree to meet on-line friends face-to-face without asking permission from your
parents first.
Never send photos of yourselves to anyone on-line either.

NEVER give out your password. Be skeptical of people on-line who ask for your
password. Refuse such requests. It's also a good idea to change your password
frequently.
Don't automatically believe everything you read. Most people you talk to on-line will
be sincere and readily offer information and advice, but that doesn't make them
experts.
Be courteous. Other on-line users can't hear your tone of voice or see your
expression. They know only what you type.
If someone is sending you email or chat requests that makes you feel uncomfortable,
log off and tell your parents to teacher.
Treat strangers on the Internet the same way as you would treat strangers on the
street.

Be sure you have your students fill out a school waiver or surfing agreement when
using Internet at school.
Before downloading and printing articles check length.
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Activity 3: Web Site Evaluation
With millions of pages on the Web purporting to serve educational purposes, how do
educators sort out the good from the bad, the useful ones from the time-wasters?
Librarians and other information specialists share their expertise in evaluating Web
information resources in the articles listed here. Included in this resource guide is a
checklist of questions to ask when evaluating a Web site as a potential educational
resource. More checklists are available in the articles cited.
Alexander, Jan, and Marsha Tate. "Teaching Critical Evaluation Skills for World Wide
Web Resources." Computers in Libraries 16, no. 10 (November/December 1996): 49-55.
See also: http://www.science.widener.edu/withers/webeval.htm
Auer, Nicole. "Bibliography on Evaluating Internet Resources." Blacksburg, VA:
Virginia Polytechnic Institute and State University, 1997.
http://refserver.lib.vt.edu/libinst/critTHINK.HTM
Collins, Boyd R. "Beyond Cruising: Reviewing." Library Journal 121, no. 3 (February
15, 1996): 122-24.
Descy, Don. "Evaluating Internet Resources." TechTrends 41, no. 4 (September 1996): 35.

Eades, Lynn. "Live from the Internet and Beyond . . Teaching Patrons to Evaluate
Internet Sites." University of North Carolina - Chapel Hill Librarians' Association
Newsletter, no. 143, (October 1996): 4. Also available online at
http ://www unc. eduilib/launcch/oct96n. htm#internet
.

Gilson, Tom. "Reviewing the Internet: The Infofilter Project." Against the Grain 8, no. 1
(February 1996): 58. Also available online at
http://www.usc.eduJusers/help/flick/Infofilter/atg.html
Grassian, Esther. "Thinking Critically about World Wide Web Resources." Los Angeles:
UCLA College Library, 1996.
http://www.library.ucla.edu/libraries/college/instruct/critical.htm
Hinchliffe, Lisa Janicke. "Resource Selection and Information Evaluation." Champaign,
IL: Parkland College Library, 1994, 1996.
http://alexialis.uiuc.edu/janicke/Evaluate.html
Rettig, James. "Beyond 'Cool': Analog Models for Reviewing Digital Resources." Online
20, no. 6 (September/October 1996): 52-54, 56, 58-62, 64.
Also available online at http://www.onlineinc.corn/onlinemag/Sept0L/rettig9.html
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Rettig, James. "Putting the Squeeze on the Information Firehose: The Need for
'Neteditors and 'Netreviewers." From a paper presented at 15th Annual Charleston
Conference on library acquisitions and related issues, College of Charleston, Charleston,
South Carolina, Friday, November 3, 1995.
http://vvww.swem.wm.edu/firehose.html
Scholz, Ann. "Evaluating World Wide Web Information." West Lafayette, IN: Purdue
University Libraries, 1996.
http://thorplus.lib.purdue.edu/library_info/instruction/gs175/3gs175/evaluation.html
Schrock, Kathleen. "Kathy Schrock's Guide for Educators: Critical Evaluation Surveys."
Dennis, MA: NH Wixon Middle
School, 1995-97.
http://www.capecod.net/schrockguide/eval.htm
Smith, Alastair G. "Evaluation of Information Sources." The World-Wide Web Virtual
Library, 1997.
http://www.vuw.ac.nztagsmith/evaln/evaln.htm
Smith, Alastair G. "Testing the Surf: Criteria for Evaluating Internet Information
Resources." The Public-Access Computer Systems Review 8, no. 3 (1997).
http://info.lib.uh.edu/pr/v8/n3/smit8n3.html
Tillman, Hope N. "Evaluating Quality on the Net." From a paper presented at Computers
in Libraries, Hyatt Regency Crystal City, Arlington, Virginia, Monday, February 26,
1996.

http ://wvvw.tiac.net/users/hope/findqual.html
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************************************************************************

A Checklist of Questions for Evaluating Web Sites
Who is the author/source?
What are the author's reputation and qualifications in the subject covered?
Is the information on the site accurate?
Is the information presented in an objective, balanced manner?
How does the site compare with other sites on the same subject?
Does the site contribute something unique on the subject?
Is the material on the site covered adequately?
How current is the information?
Is the site appropriate for the intended audience?
Is the information well-written?
How stable is the connection to the site?
How well is the site maintained?
Does the site tell you when it was last updated?
If there are links to other sites, do they work?
Is it easy to move around and locate information on the site?
Does the site require additional software or hardware?
Do illustrations, video, or audio add value to the site?

Note: The above information was adopted from (URL: http://www.unc.eduicit/guides/irg49.htm1) Maintained by: Carolyn Kotlas Center for Instructional Technology, Academic &

Technology Networks, University of North Carolina at Chapel Hill
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Educational Web Sites Evaluation Form
Use this form to record complete information on educational Web sites you discover as you explore the
World Wide Web. The information can be used to help you evaluate the site's usefulness in terms of your
own particular needs.
Site Address/URL:

Site Name:

Check all the categories that describe the site:
Question/Answer
Student Reference
Data Source
Access to an Expert
Interactive
Student Projects
Teacher Reference
Other

Newsgroup
Professional Information
Connections to other projects

Grade Level (Mark all that apply):
K

1

2

3

4

5

6

7

8

9

10

11

12

T

Educational Setting (Mark all that apply):
Individual students
Student groups

Downloadable content
Interactive time necessary

Completely interactive

Social Studies
Arts
Business
Physical Education

Science
Music
Foreign Language

Subject Areas (Check all that apply):
Language Arts
Mathematics
Careers
Health education

Rate the Site Performance:
Exemplary

Adequate

Unacceptable

Content
1. Is it correct, accurate?
2. Is it from an authoritative source?
3. Is it free from stereotypes and bias/
4. Is this the best medium for this information?
5. Do the images enhance the content

Educational Value
1. Is the information useful?
2. Is the information readable by students?
3. Is the information available elsewhere?
4. Can students collaborate with other sites?
5. Can teachers share results/
6. Does the site respond to student questions?

Technical Quality
1. Does the site work the way it is intended to
work?
2. Do all the links work?
3. Is the home page concise and quick to view?
4. Are lengthy picture files saved for later pages?
5. Is the menu clear, informative, and current?
6. Is the navigation for the site obvious?

Overall Rating
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Activity 4: Censorship & the Web

Strategies to prevent your students accessing inappropriate materials on the Web:
I. Internet Surfing Agreement
You or your school district should develop an Internet surfing agreement that should
specify all of the navigation policy. Have your students' parents or guardian sign the
agreement before bringing your students on the Web.

2. Set security system in the classroom computers.

Set username and password in all of your classroom computers. Therefore, your
students won't be able to access to the Web while you are not in your classroom.

3. Install filtering software in your classroom computers

BEST COPY AVAILABLE
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Software for Filtering Web Materials
1.

Cyber Patrol
http ://www.cyberpatrol.com/

Cyber Patrol is the Internet filtering software rated the best by industry and
leading magazines. Cyber Patrol is used to manage Internet access, limit the total
time spent online, and restrict access to Internet sites that you deem inappropriate.
2.

Surf Watch
http://www.spyglass.com/showcase/surfwatch.html

Protect your kids on the Web. Surfwatch is the first software product that blocks
sexually explicit material on the Internet.
3.

SurfControl
http://www.surfcontrol.com/

SurfCONTROL is a family of products, specifically designed for business. It
gives you the management tools to monitor, control, report and manage 'who can
do what, when and how?' with all your Internet and Intranet services
4.

Net Nanny
http://www.netpartner.co.uk/netnanny/

Net Nanny allows you to monitor, screen and block access to anything residing
on, or running in your PC, whether you are connected to the Internet or not, and in
real time.
5.

Web Sense
http ://www.netpartners.com/products/index.html
WebSENSE is designed to promote professional use of the Internet by effectively
allowing an organization to monitor, report and manage internal Internet use. It
gives you the flexibility to fine-tune your Internet access policy. You can choose
to monitor, block or screen (the combination of both). With WebSENSE in place,
you'll easily minimize unprofessional Internet use.

6.

WizGuard
http://www.wizguard.com/

Windows 95 software to block and monitor access to pornographic web sites.
Free trial version available.
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Activity 4: Testing on the Web

Evaluation is an essential part in teaching and learning process. Electronic testing via the
Web provides an promising new form of evaluation in instruction. Following are the
Web sites containing with Web-based testing:
Simple On-line Interactive Test-generator (SOIT)
http://www2.ncsu.edu/ncsu/cals/soit/
This tool makes it extremely easy to generate Web-based interactive multiple-choice tests
and quizzes. Students have responded very enthusiastically to the opportunity to work
through tests at their own pace, and receive immediate feedback. Using this tool,
instructors can optionally choose to receive an e-mail message describing each student's
test results in detail, or else design the tests to be completely anonymous.
1.

Internet-based Training with IBT Author
http://ibt.testprep.com/
Docent Software Inc. is the creator of IBT Author, an enterprise-level software solution
that allows organizations to create, deliver and administer training and assessments on the
Internet and/or corporate Intranets.
2.

Exam Writer v.0.1
http://ibt.testprep.com/
Easy to use resource which allows teachers to create multiple choice tests on the Web.
It doesn't require that you have access to a Web Server.
3.

4.

Trivia Quiz
http://osiris.sund.ac.uk/online/quiz/quiztime.html
A 25 question multiple choice quiz open to everyone on the web

5.

Vice Presidents Trivia Quiz
http://www.catsdogs.com/veepquiz.html

6.

The Interactive Pub Quiz
http://dspace.dial.pipex.com/mcinroy/quiz.htm
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Teleauthoring

Activity 1: Planning a Lesson

I

L

Lesson plan guidelines:
Section:

Instructions:

Title of Page

This is the title that will appear in the
browser's "bookmark."

This is the first heading that appears on

Lesson Title / Main Header

your actual page.

What do you want to accomplish with this

Lesson Objectives

lesson?

Lesson Audience

For whom is this lesson intended - could

Information about your lesson / Body Text

include grade level
This is where

you

write

enough

information about your lesson that we

URLs to support your lesson

would know how to duplicate it. This can
include a general description, time frame,
materials, etc.
You really are not expected to know these
before you come to class. If you wish, you
can leave this section blank.

BEST COPY AVAILABLE
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Activity 2: Graphic Resources

Graphic Resources on the Web
1.

Axem Textures
http://axem2.simplenet.com/heading.htm

2.

Boersma's Clicp arts
http://www.ecn.bgu.edu/users/gas52r0/Jay/home.html

3.

The Clip Arts Universe
http://www.nzwwa.com/mirror/clipart/index.html

4.

The Clip Arts Connection
http://www.ist.net/clipart/index.html

5.

Prinzess Graphic Collection
http://www.acadiacom.net/graphics/

6.

Leo's Icon Archives
http://www.silverpoint.com/leo/lia/
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Activity 3: Web Page Development with Netscape Communicator Composer
I

Objectives:
After the workshop, learners will be able to create a decent personal homepage, locate
clip arts resources, insert a graphic, create a table, and making links.

What is Netscape Communicator Composer?
Netscape Composer is an embedded HTML editing software with Netscape
Communicator.
When you are in the Netscape Communicator, click under
Communicator, Composer. Then, the following window will show. Its icon-based
interface automates many of the time-consuming tasks involved in building web pages.
When you open Netscape Gold Editor, the following design window appears.

Technology Tips: Opening the page in Composer
Go to the File menu.
Select Edit Page.
Now, you should have this page opened in Composer.
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Composer is just like a word processor. The easiest way to learn it is to just have some
fun and explore it. I've given you some ideas.
Important: You must save this document every five to ten minutes.

To Save a Document:
1.

2.
3.

Move your mouse arrow to the File menu located in the upper left of the screen
and click once with the left mouse button.
Move your mouse arrow and select Save.
You may use Save As to save a new html file. In the entry box located to the

right of File name enter a new name for the file. You should call

it

"lastname".htm.

Technology Tips: Working with text
Type some text and center align it horizontally in the space below. It doesn't matter what
you type.

Hint: If you don't know what the icons mean at the top of Composer - rest your mouse
over each icon for a few seconds.
This icon looks like a bunch of lines and uses the word "alignment".

Oops - I forgot to bold and italicize the word "Hint". Can you do that for me?

Technology Tips: Inserting a graphic
Now, put a graphic into the page.

Hint: Point the mouse arrow over the graphic. Click the right mouse button. Read
through your options and select one that will let you have a copy of this image. If you
don't like these options, try copy and paste under the Edit Menu. (You need to select the
item that you plan to copy - before you copy it!) If you need to select a graphic - click
your left mouse button on it - while in Composer. You can also try the "drag and drop"
method.

Hint: Click your mouse on the graphic icon (called Insert Image) or select Image from
the Insert Menu. Remember! the flashing cursor needs to be in the box where you want
to place the image/graphic. This will give you an even more sophisticated way to insert
the image. With this as your method, you can even size the graphic/image
which is usually done in the number of pixels in the graphic.
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Technology Tips: Working with tables
Put a 3 by 5 table in the space below. That means rows and columns - not inches!

Remember! the flashing cursor needs to be where you want to place an image/graphic,
text or table. Play with the Border Line Width. (Small hint -Once you've created the
table, point the mouse arrow at it and right mouse click - Table Properties)
Hint: Once you have created a table and would like to change the Table Properties, you
do not need to click on the Table icon again. Try pointing at the table and using the right
mouse button.
Put a 3 by 5 table in the space below and see if you can change the background color of
the table! Can you change the background color of only a few cells and not the entire
table?

Hint: This may be a tough one. Remember the right mouse click and the Table
Properties and hunt for an option. Now, look for a place where you can change either a
Row or a Cell.

Hint: You may want to go to the Edit menu and select HTML Source. This will bring up
an option to select a text software program in which to view the code. Brace your self for
a challenge if you take this route, but it will enlarge your horizons if you do not know
HTML.

I created the table below, but I made too many rows. Can you delete one of the rows for
me?

Oops, what a minute. I did need 4 rows. Can you go back and add a row?

Hint: Place the flashing cursor in the Cell at the lower right hand corner of the table and
hit the Tab Key. What happened?
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I created the table below, but I made too many columns. Can you delete one of the
columns for me?

Oops, again. I did need 6 columns. Can you go back and add a column for me?

Technology Tips: Put a horizontal line.
Can you check your spelling?
Hint: Check Spelling is a tool.

Make a numbered list in the space below. Maybe list your top five records of all time.

Make an unnumbered, bulleted list in the space below. Maybe list the things you need to
get at the grocery store.
Change the size of this text.

Change the color of this text. Highlight it first.

Hint: Look to the right of where you can change the size of the text.

Technology Tips: Inserting a link
Hint: Remember, words on web pages that are underlined and in a different color are
Links to other web pages. What graphic on the tool bar at the top of the screen will let
you create a link? Need some more help? Highlight the Link in the right box then click
on the Link (chain) icon in the Tool Bar to see what information was used to create the
Link.

Try creating a few links of your own. You may write down names of links and its
URLs in the following:
Name of the Web site

Address/LTRL
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Technology Tips: Change a background color
To add a color in your background, click under Format, Page Color and
Properties. Then click at the label named Colors & Background. At the middle of the
appearance window, click on background box, and then you can choose any color you
like.

To insert a background graphic, at the bottom of the above-mentioned appearance
window, in Background Image box, choose use image and then enter file name of the
image you would like to apply in your home page (You may refer to the following page).
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Technology Tips: Viewing your page
Hopefully you have been saving your page as you go along! If not, then do that now.

Hint: Would you like Composer to automatically save for you ever so often? Select
Preferences under the Edit Menu. Single left click on Composer and ask the program to
Save for you! While there enter your own name as the author if you like!

Go to the File Menu - and select Browse Page. (That is a new window in Netscape
Communicator.)

BEST COPY AVAILABLE
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Glossary
ANSI

American National Standards Institute

ARPA

In the late 1960s, the U.S. Advanced Research Projects Agency (ARPA)
launched another of its many serendipitous explorations of interesting
technologies: to create computer hardware and software to this packetswitching network to experiment with what they did build. The goal was to
economize on the use of "long-haul" broadband telephone lines (longdistance leased lines, which were much more expensive back then). Then
initial intent of the network was to connect a handful of heterogeneous
computers among geographically dispersed locations. This network became
named the ARPAnet.

AUP

Acceptable use Policy

Active X

One of Microsoft's versions of a scripting language for the Internet. This only
works on machines running Windows 9X or Windows NT.

Applet

A small program written in Java programming language.

Button

A picture on the screen or a device on the keyboard that does something when
it is clicked or pressed.

Bit

The smallest unit of data for computer data

Bookmark

The address of a Web page to which you may want to return. Netscape
navigator lets you maintain a list of bookmarks to make it easy to go back to
your favorite Web pages. Also called "favorites."

Browser

The software interface to the World Wide Web. A program like Netscape
navigator or Microsoft Internet Explorer, based on NCSA Mosaic.

Byte

A group of eight bits.

CERN

Organization Europeenne pour la Recherche Nuclearie

CGI

Common Gateway Interface. A program that runs on the server computer for

processing data submitted via Web pages, for providing dynamic web
content, etc.. These can be programmed in ahnost any language, such as
PERL, C++, JAVA, Visual Basic.

Click

What you do when you press on the mouse button.

Chat

To talk to other network users in real time.

DNS

Domain Name Server - A computer on the Internet that converts between
domain names and IP address. Example: aol.com and 140.198.23.4

Dialogue box

A window with a few extras; an alert or message window which can either
permit activity outside itself or deny clicking outside the dialog.

Download

To transfer a file from a remote to a local computer

Enter key

Key pressed to "enter" a command. Called "return" on Apple Computers
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FAQ

Frequently Asked Questions

FTP

File Transfer Protocol

GIF

A compuServe Bitmap. One of two standard graphic formats on the World
Wide Web. GIF graphics are restricted to 256 colors.

GUI

Graphical User Interface

HTML

Hypertext Mark-up Language, The language used to write pages for the
World Wide Web. This language lets the text include codes that define fonts,
layout, embedded graphics, and hypertext links.

HTTP

Hypertext Transfer protocol. The way in which WWW pages are transferred
over the Internet. URL's for Web pages start with http://.

Homepage

The entry page, or main page, of a Web site. If you have a home page, it's the
main page about you. A homepage may contain links to other Web pages.

IP

Internet Protocol

ISP

Internet Service Provider

Internet

Generally, any collection of district networks working together as one.

Image

Data representing a two-dimensional scene. A digital image is composed of
pixels arranged in a rectangular array with a certain height and width. Each

pixel may consist of one or more bits of information, representing the
brightness of the image at that point and possibly including color information
encoded as RGB triples.

Intranet

An intemet that is cut off from the Internet. All of the computers on the
intranet can talk to each other, but they cannot talk to computers outside on
the Internet

JAVA

A programming language, much like C++. This is not compiled in the usual
sense for specific Operating Systems or microcomputers. It is turned into
JAVA byte code for the JAVA virtual machine. The virtual machine is the
only program compiled for a specific machine or OS. This, in theory, would
like allow one version of a program to run on any machine with a JAVA
Virtual machine.

JPEG

Joint Photographers Group image format. Designed for storing photographs,
JPEG's are files that can store upwards of millions of color, and are one of
two graphic formats standardized among WWW browsers.

Javascript

A scripting language that can cause your browser to do cool stuff. This works
with Netscape and Internet Explorer.

Listsery

An automatic mailing list server developed by Eric Thomas for BITNET in
1986. When e-mail is addressed to a LISTSERV mailing list, it is
automatically broadcast to everyone on the list. The result is similar to a
newsgroup or forum, except that the messages are transmitted as e-mail and
are therefore available only to individuals on the list.
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Link

A hypertext connection that can take you to another document or another part
of the same document. On the WWW, links appear as text or pictures that are
highlighted.

Location bar

The text box near the top of the window in Netscape which shows the URL
for the page you are viewing.

MacTCP

TCP/IP for the Macintosh.

Microsoft Internet
Explorer

The Web browser vigorously promoted by Microsoft company

Netscape
Communicator or
Netscape navigator

A popular Web browser published by Netscape company.

PPP

Point-to-Point protocol

Progress bar

An indicator of progress of page download or other activity. The Netscape
progress bar is located in the lower left of the screen.

Remote computer

A computer not located at your physical location. A computer that you are
connecting to but you are not actually seated at its console.

Status bar

An indicator of status of page download or other activity. The Netscape
status bar is located in the lower left of the screen.

Search Engine

A program that searches documents for specified keywords and returns a list
of the documents where the keywords were found. Although search engine is

really a general class of programs, the term is often used to specifically
describe systems like Alta Vista and Excite that enable users to search for
documents on the World Wide Web and USENET newsgroups.

Shareware

Computer programs that are easily available for you to try with the
understanding that, if you decide to keep the program, you will send the
requested payment to the shareware provider specified in the program.

Site

A location on the Internet/World Wide Web.

URL

Universal Resource locator.

A standardized way of naming network

resources, used for linking pages on the WWW.

Upload

To transfer a file from a local to a remote computer.

Usenet

A worldwide bulletin board system that can be accessed through the Internet
or through many online services. The USENET contains more than 14,000
forums, called newsgroups, which cover every imaginable interest group. It is
used daily by millions of people around the world.

WWW

A hypermedia system that lets you browse through lots of interesting
information.

Web page

A hypertext document on the Web
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Zone

The last part of an Internet host name. If the zone is two letters long, it is the
country code in which the organization that owns the computer is located. If
the zone is three letters long, it is a code indicating the type of organization
that owns the computer.
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